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Copyright 
(C) 2001-2008, DYNACOM Co., Ltd. All rights reserved.  
Except as permitted under copyright law, no part of this manual may be reproduced or distributed in any form or by any 
means without the prior permission of DYNACOM Co., Ltd. All copyright pertaining to the software reverts to 
DYNACOM Co., Ltd. 
 
 
Particular notes 
The software has been developed on the basis of extensive research. The software shall not be liable 
for any losses or any direct, indirect, incidental, consequential, or other damages 
suffered by the licensee or others resulting from the use of the program or arising from any breach or warranty.  
All copyright pertaining to the software reverts to DYNACOM Co., Ltd. No copies of the software, the User Guide, or 
any portions thereof may be made by you or any person under your authority or control without the prior permission of 
DYNACOM Co., Ltd. 
Insert the “Protect key” into a port of your computer to use the SNPAlyze (Basic product) software. The software 
controls the user using the Protect key. Be careful not to break or lose the Protect key. (A 
replacement Protect key will not be provided free of charge, it must be purchased.) The software will be updated without 
prior notice.  
 

Trademark 
The Bootstrap method uses random numbers obtained by Mersenne Twister method. (Mersenne Twister method; 
Copyright (C) 1997, 1999; Makoto Matsumoto and Takuji Nishimura.) (In the trial product, the Bootstrap method will 
not be available for use.) 
 
“DYNACOM” is a registered trademark of DYNACOM Co., Ltd. in Japan.  
SNPAlyze is a registered trademark of Dynacom Co., Ltd. in Japan and/or in the U.S. Patent and Trademark Office. 
“Windows”, “Microsoft” and “Excel” are registered trademarks of Microsoft Corporation. All other products are 
trademarks of their respective companies. 
 
 

SNPAlyze Ver.7 Standard / Pro 
User Guide 
 
First Printing: 25 January 2008 
Published by DYNACOM Co., Ltd. 
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1. Introduction 

 
(1) Concept 
In recent times, the widespread use of SNP and Microsatellite in both industrial and academic research has led to a 
growing demand for genotyping platforms. In addition, the high performance of genotyping technology creates large 
quantities of SNP and Microsatellite data. As a consequence, a powerful software capable of performing association 
studies between a massive amount of genotyping data and clinical information is required. 
Dynacom experts developed SNPAlyze for obtaining genetic marker SNPs of genetic diseases and identifying disease 
susceptibility gene(s) and drug susceptibility gene(s) by evaluating their Statistical significance from SNP and 
Microsatellite data. Further, this software is capable of analyzing genotyping data files in various formats and displaying 
them graphically. SNPAlyze enables an analysis based on the following five strategies: “Case-Control Study,” “Linkage 
Disequilibrium Analysis,” “Haplotype Inference,” “Case-Control Haplotype Analysis (Permutation test),” “Haplotype 
Block Analysis,” “Hardy-Weinberg Equilibrium Test,” and “Logistic Regression Analysis (HealthSketch Ver.2.5 or later 
is required).” 
In particular, applying “Akaike's information criterion (AIC),” for some analyses enables highly accurate results in the 
case of non-ambiguous judging of the significance level. In addition, the “Bootstrap method,” which evaluates the 
reliability of the statistical value, is available for some analysis methods, such as “Case-Control Study,” “Linkage 
Disequilibrium Analysis,” and “Haplotype Inference.” 
 
(2) Hardware requirements 
  

Notes  
1. User management is conducted by using a protection key on this product. Therefore, one USB port that 

connects the protection key is necessary at the time of software execution. 
 
2. If you save the results in Excel file. In order to view these results, software which can open and view an Excel 

file must be installed beforehand. 

Item Detail 
Standard Pro System 

Windows 2000/XP/Vista 
RAM 512 MB or more 1 GB or more 
Disk space 100 MB or more 1 GB or more 
Others CD-ROM drive      (for software installation) 

USB port Interface      (details are as follows) 
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(3) Consent to use  
SNPAlyze and its User Guide can be used upon the following terms and conditions. Please read the License 
Agreement carefully. Dynacom is willing to license the software to those users who agree to the terms of this License 
Agreement. 
 

(4) Technical Support 
Thank you very much for choosing Dynacom's software.  
Please note that technical support is available only to registered users. Please fill the enclosed SNPAlyze User 
Registration form and return it to us. No technical support is provided to non-registered users.  
We offer free support services for a period of 1 year after your purchase, only via Electronic Contact Information. Please 
state your problem(s) as precisely as possible and contact us at info@dynacom.co.jp or our support center given below. 
Be sure to include your name, the serial number, and configuration information in an e-mail. If you desire to extend the 
support services for an additional year, it can be purchased at a nominal rate. 
 

Support Center 
Developer DYNACOM Co., Ltd.  
Address Yokohama-west Bldg 4F, Kusunoki-chou 27-9, Nishi-ku, 

 Yokohama-shi, Kanagawa-ken, JAPAN. 
 

Tel     +81-45-321-7800 
Fax +81-45-411-5860 
 

Electronic Contact Information 
E-mail info@dynacom.co.jp 
URL http://dynacom.jp/ 
 

 
(5) Limitation in analyses 
SNPAlyze has the following limitations for analyses:  

  

 
*HealthSketch Ver.2.5 or later is needed to be installed in order to use this function. 
 

Products comparison 
Major functions 

Standard Pro 
Sample 1,000 10,000 
Hardy-Weinberg Equilibrium Test  Up to 2560 loci 
Case-Control Study Up to 2560 loci 
Linkage Disequilibrium Analysis Up to 1000 loci 
Haplotype Inference Up to 30 loci Up to 40 loci 
Case-Control Haplotype Analysis  Up to 10 loci 
Haplotype Block Analysis Up to 1000 loci 
Bootstrap ○ 
htSNP identification ○ 
Corresponds to Microsatellite data ○ 
Open and Save SNPAlyze Data file  ○ 
Cooperate with HealthSketch ○ 
 - Logistic Regression Analysis* Up to 2560 loci 
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2. List of Functions & Flow Chart of Analysis  
 The method of analysis used by SNPAlyze is as follows: 
 (The functions are explained in detail on each page.) 

         
               (Page) 
Hardy-Weinberg Equilibrium Test     20 
Case-Control Study      24 
Linkage Disequilibrium Analysis    33 
Haplotype Inference     44 
Case-Control Haplotype Analysis (The Permutation test)  51 
Haplotype Block Analysis     57 
Cluster Analysis      65 
Logistic Regression Analysis     68 

*HealthSketch Ver.2.5 or later is required for Logistic Regression Analysis. 
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3. Project Settings 
In order to use SNPAlyze, configure the project settings. Please configure the format of genotyping data, etc., at this 
point. Further, refer to the maximum sample size and Polymorphic marker size that can be simultaneously processed. 
Remember that the program cannot perform the subsequent analysis if not configured.  
 

 Process 
       Click “Project Settings” in the Option menu. The Project Settings dialog box appears.  
     Please configure the following items. 
 
(1) Genotyping data  
The format of genotyping data is configured here. Please input the special symbol (“slash” or “comma”) that is used for 
the separating character used to represent each SNP and Microsatellite genotype by two alleles (A/G, 133/135, etc.). In 
order to correspond to a prior version format, it is possible to input each genotype using a unique string. In this case, 
please assign a string to represent each genotype. 
 
 
 
 
 
 
 
 
 
 
 

The articles in which setup and reference are possible are as follows: 
 Separate alleles with:  

Please assign the separating character (slash or comma) for representing the genotype by two 
alleles. 

 Maximum allele number per locus: 
Display the available number of alleles per locus. (For reference only. The number cannot be 
changed.) 

 SNP data  
Please input the string that represents each genotype when the SNP genotype data has been 
inputted using a unique string. 
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(2) Compare string  
You can select to discriminate between lowercase and uppercase characters when totaling genotyping data. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Please select one of the following. 

 Case sensitive 
If you wish to discriminate between lowercase and uppercase characters, check “Case sensitive.” 

 Case insensitive 
If you do not wish to discriminate between lowercase and uppercase characters, check “Case 
insensitive.” 

 
For example, if you use both uppercase and lowercase of the same character to describe the Major and Minor 
allele as follows, check the Case sensitive check box. 
 
 
 

 
 
 
(3) Data limitations 
You can refer to the maximum number of columns and lines per data sheet into which genotyping data can be input. If a 
large amount of data is to be processed, this software is able to add the required number of data sheets as Excel is. 
Furthermore, you can refer to the maximum number of data sheets that can be added. (For reference only. The number 
cannot be changed.) 
 
 
 
 
 
 
 
 
 
 
 

 
 
The articles that can be referred to are as follows: 

 Maximum marker size per sheet  
Display the maximum number of Polymorphic markers that can be inputted in one data sheet. 

 Maximum sample size  
 Display the maximum number of samples. 
 Maximum sheet size  

Display the maximum number of data sheets. 

AA Major allele homozygote 

Aa Heterozygote 

aa Minor allele homozygote 
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(4) Analysis limitations 
You can refer to the maximum number of samples and loci that can be processed simultaneously by each analysis 
method. (For reference only. The number cannot be changed.) 
 
 
 
 
 
 
 
 
 
 
 
 
(5) Others 
Initialize the setting conditions for each analysis, and warning messages. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Show all warning messages: Initialize the display setting of warning message. (Refer to 
section “14-(1)” for more information.)  

 Use default analysis settings:  Initialize the setting conditions for each analysis. 
   

 Click the “OK” button when you complete configuring the “Project setting” dialog box. 
These setting conditions are applied to all the data used for analysis. The settings here are adapted to all the 
data that will be analyzed. When the input form of Genotyping data etc., is changed, it is necessary to 
reconfigure. 
 

A: Major allele, a: Minor allele 
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4. Input/Output 
 
(1) File format 
SNPAlyze is able to read and analyze the following types of SNP and Microsatellite data files: 

[1] Microsoft Excel files (.xls, .xlsx format) 
[2] TSV (Tab Separated Values) / CSV (Comma Separated Values) file 
[3] Biotage PSQ96 export file 
[4] ABI company PRISM7900 export file 
[5] SNPAlyze Data file (.slyz format) 

Since multiple data sheets can be imported, the comparison of analytical results between different data sheets is possible.  
 
< File format > 
Please input the data in the form of English one-byte characters. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Sample index 
Each sample name is inputted into the first column. The sample name inputted here is used 
when outputting the diplotype. (Refer to “9-(2) Explanation of the results” for information on 
output diplotype.) 

 
2. Genotyping data 

SNP or Microsatellite genotyping data are inputted with two alleles and a separating character 
(slash or comma). For instance, in the above data sheet, genotype is represented as A/C, 
133/135, etc. 
In order to correspond to a prior version format, it is possible to input each genotype with a 
unique string. For instance, for SNP-1 in the above data sheet, A/A, A/C, and C/C represent 
three genotypes (Major allele homozygote, Heterozygote, and Minor allele homozygote). It is 
possible to analyze the data, which are defined as those three genotypes with unique strings, 
such as 1, 2, and 3. However, these must be unified among the data sheets in use. (Refer to “3- 
(1) Genotyping data” for information on genotyping data settings.) 

 
3. Group data (Subject) 

In the case of either “Case-Control Study,” or “Case-Control Haplotype Analysis,” or “Logistic 
Regression Analysis” the column inputted with the trait information of each group (for example, 
“Case,” or “Control”) is required. Please register the Subject before conducting the analysis. 
(Refer to “5- (1) Registration of Subject” for information on registration of subject.) 
 
 

3. Group data (Subject)  

1. Sample- index

4. Explorer 

SNPAlyze data sheet 

2. Genotyping data 
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        4. Explorer 

The data sheet being imported  
and the sheet of the analytical  
result obtained by using this  
data sheet are displayed on the  
Data tab. Each sheet can be  
redisplayed by clicking on  
Explorer. When multiple data  
sheets are imported, the data  
sheet can be displayed as the  
topmost window by clicking  
it on this screen. When the  
data has been saved in the  
software for more than 60  
days, the last date (according  
to the Western Calendar) on  
which the data was saved  
instead of the period  
for which the data was saved,  
is displayed on the right-hand  
side of the name of the data  
sheet, while the analysis  
completion date is displayed  
on the right-hand side of each  
analytical result. In the Project  
settings tab, the analytical  
conditions can always be viewed. 

 
 
 
(2) Input SNP and Microsatellite data  

Enter SNP and Microsatellite data using the keyboard. 
 

 Process 
     1. Click “New” in the File menu. 
     2. An empty data sheet appears. 
     3. Enter the SNP index and SNP data in accordance with the previous page. You can also copy and paste the data  
     from Excel or text files into an empty data sheet. 
  

Notes (Index) 
1. Polymorphic marker 

The index of any Polymorphic marker must not be as same as that of any other columns.  
2. Null data and typing error data 

SNPAlyze is capable of considering null (void) data and typing error data for estimating Haplotype Inference. (Refer 
to “9-(1)” for information on “Parameter tab in Haplotype Inference.”) However, they are not recognized in other 
analyses. 

3. Discrimination between lowercase and uppercase characters: 
When totaling genotyping data, discrimination between lowercase and uppercase characters depends on the Compare 
string setting (3- (2) Compare string) 
If you wish to discriminate between lowercase and uppercase characters, check the Case sensitive check box. 
Otherwise, check the Case insensitive check box. 

  
 

Display last saved 
date of imported 

Finished time of 
each analysis 

Old data (last 
saved date more 
than 60 days 
before) have this 
format 
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Notes (Resize a data sheet) 

1. Click “Sheet Size” under “Edit” in the File menu; this provides a dialog box showing the maximum number of 
columns and rows. 
2. To change these values, input appropriate values into the “Marker size per sheet” and “Sample size” text boxes; then,  
  click the “OK” button. 
 
 
 
 
 
 
 
 
 
(3) How to open a file 

[1] In case of Excel and text files 
 

 Process 
     1. Click “Open” in the File Menu. An “Open” dialog box will appear. 
     2. Select a file for analysis. 

 

 

 

 

 

 

 

 
 
 

3. Check “Polymorphic marker” when the selected file includes a Polymorphic marker-index. In the same manner, 
when the selected file includes a sample-index, check “Sample.” (Refer to “4-(1) File format” for detailed 
information on analysis data sheet format.) 

 
    4. Click the OK button. This closes the dialog box. 

 
 The contents of the data window are displayed after a read operation if the “Show Data Information” check box  

   is checked. 
 
 
 
 
 
 
 
 
 
 
 

Specify the index information of the selected file. 

The selected file path appears. 

Show Data Information check box 

This window shows the identified genotyping data and 
group data types in the “Data” column and the 
summation of the number of each identified type from 
the entire inputted sheet in the “Count” column. 

“Marker size per sheet” text box 
   Input the maximum number of columns.  
“Sample size” text box 
   Input the maximum number of rows. 
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[2] SNP data import (Biotage PSQ96 export file, ABI PRISM7900 export file) 

It is possible to import and analyze a text file exported by the above typing devices. 
 

 Process 
1. Click “Import Typing Data” in the File Menu. The “Data Import” dialog box will appear. 
 
 

 
 
 

 

 

 
 
 
 

2. Specify the folder that contains the file chosen to be analyzed from the “Date import” dialog box. 
3. Select a file from the “File” list box and click the     button to add the file to the “Selected File” list box. 
4. Input the information for the added file in the “Selected File” list box.  

 
 File Attribute frame (input attribution of the file) 

Select “snp to samples” when you wish to handle several samples (versus) one SNP. 
By contrast, select “sample to snps” when you wish to handle one sample (versus) several SNPs. 

 
     File Format 

Select “PSQ96,” when the file is a PSQ96 export file. 
Select “Prism7900,” when the file is a Prism7900 export file. 

 
 Replace (Configure the method of replacing character strings) 

Select “Automatically,” for automatic replacement of the character strings. 
Select “Manually,” for manual replacement of the character strings. 

 
5. Click either the “OK” or “Apply” button when you complete configuring the “Data Import” dialog box. 

 
 The selected file is read and the required data sheet appears. 

 
 
 
 
 
 
 

 

File list box 
All files, which are included the folder you select, appear. 

Replace frame 
Select the method for replacing the character strings 
that are used in the data sheet. See paragraph 4 for 
further details. 

File Format frame 
Specify a typing device. 

Selected File list box 
The file selected in the “File” list box appears. 

Drive list box 
Select a drive for the exported file. 
 
File Attribute frame 
Specify a file attribution. 
See paragraph 4 for further 
details.

Folder list box 
Select a folder for the exported file. 
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Notes (Biotage PSQ96 export file, ABI PRISM7900 export file) 
1. Relationship between WELL and the Sample in reading several files. 
“snp to samples:” The sample that corresponds to each WELL must be identified among the export files. 
“sample to snps:” The SNP that corresponds to each WELL must be identified among the export files. 

 
2. Replacing character strings with numeric values in data sheet. 
Character strings in “Prism7900” are automatically replaced as shown below:   

Allele1 1, Both 2, Allele2 3 
In case of “PSQ96,” characters are replaced with slashed strings. An example is given below. 

G/G 1, G/T 2, T/T 3 (in case of G/T) 
Notice: Replacement does not occur when there are no heterozygous combinations. 

 
Notes (Index) 

1. Index data  
All column indexes must be different from each other. 
All row indexes must be different from each other. 
 
2. Column Index  
This appears in the results of Haplotype Inference only.  
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[3] SNPAlyse Data file  
This file includes genotyping data and all analysis data collectively. If you open a file that saved as this file 
format, the genotyping data and all analysis data will appear. You can continue your analysis, or share the 
genotyping data and all analysis data by distributing this file to other SNPAlyze users. (Please mind this file 
include genotyping data) 

 
 

*How to prepare SNPAlyze Data file  
After your analysis, the genotyping data and analysis data can be 
saved into a SNPAlyze Data file by clicking “Save SNPAlyze” or 
“Save SNPAlyze As…” in the File menu. 

 
 
 

 Process 
1. Click “Open” in the File Menu. An “Open” dialog box will appear. 
2. Choose a SNPAlyze Data file for open. (The file extension is “.slyz”) 

 
 
 
 
 
 
 
 
 
 
 
 

 The selected file is read and the genotyping data and analysis result appears.
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(4) About Data sheet import 
 
SNPAlyze Ver. 5 or later can import multiple data sheets. The data sheet that has been imported is added to Explorer as 
follows: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Since the analytical result of each data is added, as shown in the following figure, the analytical results of different data 
sheets can be compared on the software. 
 
 
 
 
 
 
 
 
 
 
 
 
 

The result of 
data-sheet No.1
(LD-BMP) 

The result of 
data-sheet No.2
(LD-BMP) 
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5. Data Definition 
Select the SNP or Microsatellite markers for analysis. Moreover, in the case of an analysis by groups, 
please register the Subject information. It is necessary to perform the above operations before analysis. 
 
(1) Registration of subject  
In the case of analysis by groups, please select the subject indexes that include group information. Registration of the 
subject is required for the entire genotyping data according to groups, such as case-control study. 
(It is necessary to input group information for the group that each sample belongs to, when the sample is 
analyzed.) 
 

 Process 
     1. Click “Subject Information” in the Edit menu. The Subject Information dialog box will appear. 
 
 
 
 
 

2. The list of indexes included in each data sheet is displayed on the left 
side of the dialog box. Please select the subject indexes, which include 
the group information. (Selected subject indexes were inputted in the 5- 
(2) subject information combo box.) 

 
3. Click the “OK” button when you finish configuring in this dialog box. 

 
     Notes 

1. When changing the above setting, please select “Subject 
Information” in the Edit Menu and reconfigure. 

 
 
 
 
(2) Selection of Polymorphic markers and groups 
The genotyping data inputted into the data sheet is tabulated, and the total and frequency of each allele are displayed. 
Based on the information obtained from the Hardy-Weinberg equilibrium (HWE), a minor allele frequency (MAF), and 
a marker type, polymorphic markers can be automatically sorted out for analysis. Please select the Polymorphic marker 
to be used as the target for the analysis. In addition, in the case of analysis by groups, please select the group that is the 
object of the analysis. (In the case of analysis by groups, it is necessary to configure section “5- (1)” first.) 
 

 Process 
      1. Click “Data Information” in the Edit menu. The Data Information dialog box will appear. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
       

Select the index that includes the group information.  

Display polymorphic markers in the data sheet. 

Genotype Information frame: 
The number of summations and frequency 
of each genotype are displayed. 

Allele Information frame: 
The number of summations and frequency 
of each allele are displayed. 

Each type of polymorphic marker is displayed.  
You can change the marker type by clicking on a marker. 
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     2. Selection of Polymorphic markers 
The list of Polymorphic markers included in each data sheet is displayed on the left hand side of the dialog 
box. When you click the Polymorphic marker name, the information on the marker is displayed on the right 
hand side of the window (On the Genotype Information and Allele Information frame). Please select the 
markers for analysis. (The genetic markers that were selected in the Select sequence will be analyzed.) 

 
     3. Selection of groups  

The combo box in the subject information frame consists of the subject indexes that were registered in 
section “5-(1)”. The group information included in the subject data is displayed in the Group column. Please 
select the group that is the object of analysis. (The group selected in the Select sequence will be analyzed.)  
In addition, the Meaning column is editable. Each result is displayed using the group name inputted here. 
Please input a concrete group name, such as case, control, sporadic, etc. 

 
 
 
 
 
 
     
 
 
 
 
 
 
 
 
 
     
 
     4. Automatic selection of polymorphic markers 

Clicking the "Show limitations" button on the bottom of dialog box opens the settings screen, as shown in 
the following figure. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
By changing the "Check marker" option as follows, the automatic selection method of markers for analysis can be set.

Hint  
Cooperate with HealthSketch V2.5 or later, SNPAlyze perform logistic regression analysis for each SNP. 
Please refer to the following tables for input Case and Control information on Meaning column. 
 
 
 
 
 

Status Input 
Case Case or 1 

Control Control or 0 

Automatic selection results in 
the color display of a cutoff 
value part of polymorphic 
markers for exclusion. 

Select the selection criterion 
for automatic selection of 
polymorphic markers. 

Set the cutoff value and its application 
group for each selection criterion. 

Meaning column input example 

* The following values are available. (You can specify this 
value with uppercase or lowercase characters based on the 
setting in section “3-(2) Compare string”. 
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    HWE p-value 
Polymorphic markers that do not satisfy the Hardy-Weinberg equilibrium can be excluded. The selection 
criterion is the chi-square goodness-of-fit test. When the group is set, the subject group of the Hardy-
Weinberg equilibrium can be changed in the Group combo box. Moreover, the cutoff value of the p-value 
can be arbitrarily specified. (Default = 0.05) 

 
 
 
 
 
 
 
 
 
 
 
 
     Minor allele frequency 

Polymorphic markers with a minor allele frequency below the prescribed value can be excluded. When the 
group is selected, the subject group can be changed by using the Group combo box. Furthermore, the value 
of the frequency used as the criterion can be arbitrarily specified. (Default = 0.1) 

 
 
 
 
 
 
 
 
 
     Select polymorphism 

Subject markers can be selected according to the type of polymorphic markers. Select the type of subject 
markers used for analysis from the following options: SNP, Microsatellite, and Unknown. 

 
 
 
 
 
 
 
 
 
 
     5. Click the “OK” button when you finish configuring this dialog box. 

 
 

      Notes  
1. When changing the above setting, please select “Data Information” in the Edit menu and reconfigure. 

Select the group to apply to cutoff value. 
If “All” is selected, all the data are applicable. 
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6. Hardy-Weinberg Equilibrium Test 
The Hardy-Weinberg Equilibrium Test evaluates the differences between the actual observed Allele number and the 
expected Allele number in Hardy-Weinberg Equilibrium at an SNP site, which are calculated by the Chi-square test. In 
cases where the chi-square test is not applicable, the exact test and the exact test with Monte Carlo simulation are also 
available. 
 

 Process 

(1) Select the objective polymorphic markers and configure the analysis conditions. 
Click “Hardy-Weinberg Equilibrium” in the Analysis menu. The Data Setup dialog box will appear. 

    
 Select Locus Tab 

1. Selection of Polymorphic markers 
Polymorphic markers selected in section “5-(2)” are displayed in the “Selected” list box. These markers can 
be moved between the Removed and Selected list box using the     and     buttons. 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
2. Selection of the subject  
In the case of analysis by groups, it is necessary to select the subject that includes group information. Please 
check the “Subject” check box. You can select a subject index that was registered in section “5-(1)”. If you 
registered several subjects, please select one of them. (Only subject indexes chosen in section “5-(2)” from the 
group information included in the selected subjects are used.) 

 
 
 
 
 
 
 
 
 
 
 
 
 

Removed list box: 
The Polymorphic markers that 
are not selected for analysis are 
displayed. 

Selected list box: 
Objective Polymorphic markers for analysis selected 
at section “5-(2)” are displayed. 

Sheet tab: 
These tabs correspond to the page number on the data 
sheets. The Polymorphic markers contained in the selected 
sheet are displayed. 

Subject combo box: 
Display the subject index registered at section “5-(1)”. 
In the case of analysis by groups, select the subject that 
includes group information. 
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 Parameter Tab 
Configure the analysis conditions. 

 
   
 
 

 
 
 
 
 
 

 
 

 
    
1. Goodness of fit test frame 
Check here when applying Yates’ correction for chi-square goodness of fit test. This correction applies only for SNPs 
type polymorphic marker. (i.e. type number of allele is only two) 
2. Exact test frame 
Check here when applying the exact test. Construction of all the possible combinations of contingency table in the exact 
test may be time-consuming when a large number of samples and type number of alleles are involved. By using the 
settings of “Maximum sample size" and "Maximum Type number of Alleles,” the exact test can be manipulated to stop 
execution when the marker exceeds the specified sample size and type number of alleles. 
3. Monte Carlo simulation frame 
Check here when applying the exact test with Monte Carlo simulation. The iteration count can be selected between 1,000 
and 1,000,000 (initial value: 1,000). Although the accuracy increases with an increase in the iteration count, the time 
required for the analysis simultaneously increases. 
 

 
 
 
 
 
 
 
 

 
 Click the “OK” button when you finish configuring this dialog box. Results will be displayed.  

    You can quit the analysis at any time by clicking the “Cancel” button. In this case, the results will not be  
    displayed. 
 
 
 
 
 
 
 
 
 
 

Goodness of fit test frame 
Check here when applying the Yates's 
continuity correction.

Exact test frame 
Check here when applying the exact 
test.

Monte Carlo Simulation frame 
Check here when applying the exact 
test with Monte Carlo simulation. 

Hint 
The time required for the completion of the exact test is short when polymorphic markers of the SNP 
type (type number of alleles = 2) are used. However, when polymorphic markers of microsatellite 
type (type number of alleles > 2) are used, the time required for the completion of the exact test is 
very long. Hence, the selection of the exact test with Monte Carlo simulation is recommended. 
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(2) Explanation of the results 
The results can be saved into a TSV file by clicking “Save” or “Save As” in the File menu. 

 
 Statistics window 

    Displaying statistics that are calculated from inputted data. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The details of the outputted item are as follows: 

 Marker type 
Displays the types of polymorphic markers, which are “SNP”, “MS”, and “unknown”. 

 Statistics 
The results of the chi-square goodness-of-fit test, the exact test, or the exact test with Monte Carlo simulation are the 
output. The cell that has a p-value below 0.05 is displayed in color. 

 Locus information 
Outputs the real number of genotypes and alleles that are observed from the original input data sheet. 

 Allele count 
Index “allele count” indicates a value twice as much as the total of the Observed values. 

 
*In the case of “p-value” is less than or equal to 0.05, the cell is displayed in red. 
**In the case of “Exact p-value” is less than or equal to 0.05, the cell is displayed in yellow. 
***In the case of “Exact p-value (Monte Carlo simulation)” is less than or equal to 0.05, the cell is displayed in green. 
 
 
 
 
 
 
 
 
 
 
 
 

Group Tab 
In the case of analysis by groups, the results are displayed per group. The 
group name (Selected in section “5-(2)”) appears on each tab. To obtain the 
result of a particular group, click the tab with that group’s name.       

Marker type Statistics Allele count Locus information 
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 Details window 
 Details window does not appear when analysis is completed. It can be displayed by clicking the [HWE- Detail  

   information] index located on the Results tab in the Explorer window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 

 

 

 

 

 

 

 

 

 

  

 

Click on the marker or group name 
to browse the results. 

 Basic information  

 Marker name 
 Group name 

 Type number of Genotype 
 Number of Genotypes 
 Type number of Allele 
 Number of Alleles 

 Allele frequency 

 Genotype frequency 

 Observed number of Genotypes 
 Expected number of Genotypes 
 Chi-square value (each Genotype) 

 Chi-square value (each marker) 
 Degrees of freedom (each marker) 
 p-value (each marker) 

 Exact p-value of marker 
 Number of generated contingency 

table in the process of Exact test  

 Exact p-value of Monte Carlo 
simulation  

 Number of iterations 
 Number of upper counts of 

generated contingency table 
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7. Case-Control Study 
In Case-Control Study, SNPAlyze evaluates the association between individual SNP markers and diseases with the Chi-
square test and AIC. AIC yields a higher degree of accuracy than the Chi-square test. Further, an odds ratio can be 
calculated. 
 

 Process 
(1) Select the objective polymorphic markers and configure the analysis conditions. 
Click “Case-Control Study” in the Analysis menu. The Data Setup dialog box will appear. 
 

 Select Locus Tab 
1. Selection of Polymorphic markers 

Polymorphic markers selected in section “5-(2)” are displayed in the “Selected” list box. These markers can 
be moved between the Removed and Selected list boxes, using the     and     buttons. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

 
 
 

2. Selection of subject  
Please check the “Subject” check box. You can select a subject index that was registered in section “5-(1).” If 
you registered several subjects, please select one of them. (Only the subject indexes selected in section “5-(2)” 
from the group information included in the selected subjects are used.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Removed list box: 
The Polymorphic markers that 
are not selected for analysis are 
displayed. 

Sheet tab: 
These tabs correspond to the page number on the data 
sheets. The Polymorphic markers contained in the selected 
sheet are displayed. 

Selected list box: 
Objective polymorphic markers for analysis selected 
in section “5-(2)” are displayed. 

Subject combo box: 
Display the subject index registered in section “5-(2).” 
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 Parameter 1  Tab 
Configure the analysis conditions. 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 1. Contingency table definition Frame 
 Select the method for defining the contingency table. It is set to “Automatically” by default. 
 
 2. Bootstrap Frame 

Select the Bootstrap check box to use the Bootstrap method. The number of iterations available in the 
Bootstrap method is between 100 and 10,000. (Initial value is 1,000.) 
 

 3. Fisher’s exact test limitation Frame 
       Analysis may take some time to complete depending on the size of the defined contingency table. You can  
       choose to skip the Fisher’s exact test by selecting this checkbox, in case polymorphic marker has values that  
       exceed the threshold values you have defined. 

 
 
 
 
 
 
 
 

 
    
 
 
 
 
 
 
 
 
 
 
 
 
 

Hint 
The time required for the completion of the exact test is short when markers of the SNP type (type number of 
alleles = 2) are used. However, when markers of microsatellite type (type number of alleles > 2) are used, the 
time required for the completion of the exact test may be very long. The time required for the analysis depends on 
the sample number and the degree of freedom in the contingency table (the total number of the contingency table 
constructed). 
Reference material (approximate indication of analysis time) 
Input data: MS type data (sample size = 50, allele = 9 and genotype = 15) 
Contingency table: 9 × 2 (allele), 15 × 2 (genotype) 
Time required: 1 min 51 s 
System: OS = Windows XP Pro (SP1), CPU = Pentium 4 (2.40 GHz), and RAM = 640 MB 

Contingency table definition frame: 
Select the method used for defining the contingency table. 

Bootstrap frame: 
To use the Bootstrap method, check the “Bootstrap” 
check box. 

Fisher’s exact test limitation frame: 
Select this checkbox to apply a limit on the Fisher’s exact 
test. 
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 Parameter 2  Tab 
Configure the analysis conditions for False Discovery Rate (FDR). 
SNPAlyze is able to calculate the q-value according to the following analysis conditions. (For details about the FDR, 
please refer to the papers listed in the “15. Reference List”)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 1. Specify lambda frame 

This can be used when you select a Bootstrap method in the Method Frame. 
In this software, q-value is calculated based on p-value and its distribution. Please set the Range and Step 
interval for estimate π0.  

 
 2. Method Frame 

Please select a Bootstrap or BH method for estimate π0. The number of iterations available in the Bootstrap 
method is between 100 and 1,000. (Initial value is 100.) 

 
 

 Click the “OK” button when you finish configuring this dialog box. Results will be displayed.  
    You can quit the analysis at any time by clicking the “Cancel” button. In this case, the results will not be  
    displayed. 

Specify lambda frame 

Method frame
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(2) Definition the Contingency table 
Contingency tables are defined in accordance with the “Subject” and SNP or Microsatellite markers selected in section 
7- (1). SNPAlyze allows you to select from two methods for defining the contingency table: “Automatically” and “User 
Customize”. 

 
 Automatically 

*Select this method when you are using Microsatellite data. 
SNPAlyze can define the contingency table automatically, and calculate the statistics from the 
original input data. The contingency tables comprise of (1) Genotype model, (2) Recessice model,  
(3) Dominant model and (4) Allele model. 
*(2) Recessive model and (3) Dominant model contingency table is only available for 2 allele 
genotypes. 
  
For example, the following contingency tables are constructed from the data set when Number of     
Genotypes = 3 and Number of Alleles = 2: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 User customize 
*This method can be used only when you are dealing with SNP-type data. 
It is possible to define a contingency table freely by combining the genotype or allele and the group. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Check “User customize” check box. 

(1) Genotype model 
 Case Control 

Major allele homozygote   
Heterozygote   

Minor allele homozygote   
 

(4) Allele 
 Case Control 

Major allele   
Minor allele   

 

(2) Recessive model 
 Case Control 

Major allele homozygote 
+ 

Heterozygote 

  

Minor allele homozygote   
 (3) Dominant model 

 Case Control 
Major allele homozygote   

Heterozygote 
+ 

Minor allele homozygote 
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In this manual, the procedure is explained for defining a 2 × 2 contingency table when focusing on the minor allele 
homozygote as follows: 
 

 
 
 
 
 

 
 

 

 

 

 

 

    Subject categories 
 1. Click the “Subject” tab and then input the number of “Subject” categories. 

 
 
 
 
 
 
 
  
 
 
 
 
 
 

 
 

 
 
 
 

     2. Select a data value from “List” and then click the       button to add it to the right side of the text field. 
 
 
 
 
 
 
 
 
 
 
 

 X1: Case X2: Control 

Y1: Major allele homotygote 
   + Heterozygote 

  

Y2: Minor allele homozygote   

Subject category 
“X1” and “X2” correspond to the names in the Category 
list box when you configure the “Subject’” category. 

SNP Data category 
“Y1” and “Y2” correspond to the names in the Category list box
when you configure the “SNP Data” category. 

Nmber text box 
Enter the number of “Subject” categories. 

List 
Only subject indexes selected in 5- (2) 
from the group information included in 
the subjects selected in 7- (1) are used. 

Category text box 
If the number in the text box is 2, two places 
of each category text box can be used. 

List 
Click and select the “Subject” category name. 
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  “SNP Data” categories 
     1. Click the “SNP Data” tab. Input the number of “SNP Data” categories.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
     2. Select a data value from “List” and then click the     button to add it to the text field. 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

 Click the “OK” button when you finish configuring this dialog box. Results will be displayed. You can quit the 
analysis process at any time by clicking the “Cancel” button. 
*The results can be displayed only if the number of iterations is more than 100 when you quit the analysis during the 
execution of the “Bootstrap method.”  
*Results are available when the “Cancel” button is clicked only when using the Bootstrap method. 
 

 
 
 

Hint 
Please select the [Allele] checkbox if you wish to categorize SNP data by allele. “Major allele” and “Minor allele” will 
be displayed in the list box. 

Category text box 
If the number in the text box is 2, two places 
of each category text box can be used. 

Nmber text box 
Enter the number of “Genotype” categories.

List 
Three SNP genotypes appear.  

List 
Click and select the “Genotype” category name. 

It is possible to add the same category name to the same category list box. 
For example, in the case that the same category name is added twice, the 
data in this category are doubled during the calculation. 
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(3) Explanation of the results 
The overall results and the statistical value of each group are shown. 
The results can be saved into a TSV file and Excel file by clicking “Save” or “Save As” in the File menu. 

 

 Statistics window 
Displaying the statistics data that calculated from inputted data. 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If you select “Automatically” option above four contingency tables are constructed, and if you select “User customize” 
option manually defined contingency table is constructed. Following statistical values are computed in each contingency 
table. 
 

 AIC (IM–DM)   AIC (IM) minus AIC (DM) 
 Chi-square   Chi-square value 
 Df    Degrees of freedom 
 p-value    Upper Probability 
 FDR q-value   Measure of significance for multiple testing. 

 
(Odds ratio is also output in the case of a 2 x 2 contingency table) 

 Odds ratio   Odds Ratio 
 Woolf”s 95%CI -Low  95% confidence interval (low) 
 High    95% confidence interval (high) 

 
Notes   

1. Background color  
In the case of AIC (IM - DM) > 0, the cell is displayed in blue. 
In the case of “p-value” is less than or equal to 0.05, the cell is displayed in red. 
In the case of “Fisher (two-sided test)” is less than or equal to 0.05, the cell is displayed in yellow. 
 
2. It is judged that the best AIC model is that where the value serves as the minimum. From this judgment, a relation 
between SNP and Disease is judged as follows.  
AIC (IM) > AIC (DM)  This indicates that an SNP and a disease are dependent.   
AIC (IM) < AIC (DM)  This indicates that an SNP and a disease are independent.  
 

Sheet tab 
These are the same for each data sheet tab. 
The analysis results of the SNP indexes 
included in the selected sheet appear. 

1. Recessive model 3. Genotype model 

2. Dominant model 4. Allele model 
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3. Bootstrap 
In the case of the Bootstrap method, bootstrap resampling techniques are performed to calculate the “Mean,” “SD,” and 
“95%CI.” 
 
 
<Explanation of the results of Chi-square test>  
 
 
 
 
 
 

 

 

 

 

 
 
 
The Statistics using the Bootstrap method are as follows: 
 
“AIC (IM-DM),” “Chi- Square,” “p-value,” and “Odds Ratio” (In the case of a 2 × 2 matrix).   
 

The results calculated using bootstrap resampling 
techniques are as follows: 
1. CI95%-Low : 95% confidence 

interval (Low) 
2. High  : 95% confidence 

interval (High) 
(The 2.5% and the 97.5% spots are shown for the 
case in which the results calculated using the 
bootstrap resampling techniques are sorted in 
ascending order. The iteration count was set in 7-
(1) Parameter tab.) 
3. Mean  : the mean 
4. StdDev  : the standard deviation 
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 Details information window 
 Details window does not appear when analysis is completed. It can be displayed by clicking the [CCS- Detail  

   information] index located on the Results tab in the Explorer window. 
 

Notes   
1. Bootstrap 
In the case of the Bootstrap method, bootstrap resampling techniques are performed to calculate the “Mean,” “SD,”  
“95%CI (Low),” and “95%CI (High).” 
 
2. Mean, Variance, SD (Quantification theory second family) 
The names of the genotypes are replaced with numeric values in the data sheet as follows: 
  
Major allele homozygote = 1, Heterozygote = 2, Minor allele homozygote = 3 
 

==================<skip>================== 

==================<skip>================== 

==================<skip>================== 

==================<skip>================== 

==================<skip>================== 

Basic information 

 Marker name 
 Type number of Genotypes 
 Number of Genotypes 
 Type number of Alleles  
 Number of Alleles 

 
*Genotype frequencies and Allele 
frequencies are also shown. 

Quantification theory 
Second family 

Display FDR settings 
 The estimation method for π0.

 For each model 
   Selected Range and Step  
      Interval for estimate π0. 
 

Sample tabulation results and following statistical 
values are computed in each contingency table. 

 AIC (IM)     
 AIC (DM)     
 AIC (IM-DM)   
 Chi-square 
 p-value        
 FDR q-value  
 Fisher’s exact test   
 Odds ratio (2×2 contingency table only) 

 

Click on the marker name to 
browse the results. 
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8. Linkage Disequilibrium Analysis 
In this method, the Linkage Disequilibrium coefficient (LD coefficient) is calculated using the difference between the 
Haplotype frequency and the Allele frequency at two arbitrary gene loci. SNPAlyze can output the LD coefficients, such 
as “D-value,” “D'-value,” and “r-square.” In addition, this software is capable of outputting “Chi-square,” and “AIC.” 
This software is also capable of displaying the graphical results of the “Linkage Disequilibrium Analysis.” 
 

 CAUTION!! 
   Be careful with linkage disequilibrium analysis when you are dealing with Microsatellite data. 
    Refer to section “14-(2) Linkage disequilibrium in Microsatellite” for further information on   
      Support Documentation 
 

 Process 
(1) Select the objective polymorphic markers and configure the analysis conditions.  
Click “Linkage Disequilibrium Analysis” in the Analysis menu. The Data Setup dialog box will appear. 
 

 Select Locus Tab 
1. Selection of Polymorphic markers 

Polymorphic markers selected in section “5-(2)” are displayed in the “Selected” list box. These markers can 
be moved between the Removed and Selected list box, using the     and     button. 
 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Removed list box: 
The Polymorphic markers that 
are not selected for analysis are 
displayed. 

Selected list box: 
Objective polymorphic markers for analysis selected 
in section “5-(2)” are displayed. 

Sheet tab: 
These tabs correspond to the page number of the data 
sheets. Polymorphic markers contained in the selected 
sheet are displayed. 
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2. Selection of subject  
In the case of analysis by groups, it is necessary to select the subject that includes group information. Please 
select the “Subject” check box. You can select a subject index that was registered in section “5-(1)”. If you 
registered several subjects, please select one of them. (Only the subject indexes selected in section “5-(2)” 
from the group information included in the selected subjects are used.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Parameter Tab 
Configure the analysis conditions. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
    Click the “OK” button when you finish configuring this dialog box. Results will be displayed. You can quit the  
   analysis process at any time by clicking the “Cancel” button. 
   *The results can be displayed only if the number of iterations is more than 100 when you quit the analysis during the  
   execution of the “Bootstrap method.”  
   *Results are available when the “Cancel” button is clicked only when using the Bootstrap method. 
 

 
 
 
 
 
 

Bootstrap frame: 
If you wish to use the Bootstrap method, check the 
“Bootstrap” check box. 

Subject combo box: 
Display the subject index registered at section “5-(1)”. 
In the case of analysis by groups, select the subject that 
includes group information. 

1. Bootstrap frame 
If you wish to use the Bootstrap method, check the 
Bootstrap check box. The number of iterations available 
in the Bootstrap method ranges from 100 to 10,000. 
(Initial value is 1,000.) 
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(2) Explanation of the results 
 
   Pairwise Data window 
    This window presents the Haplotype frequency, Linkage Disequilibrium coefficient, and Statistics for each SNP  
    pair. Each result corresponding to each group among the object groups can be obtained here. A group name  
    appears on each tab. When a tab is clicked, the results of that particular group appear. The results can be saved on a  
    TSV file by clicking “Save” or “Save As” in the File menu. 

 
 
 
 
 
 
 
 

 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
Meanings of Index are as follows. 
[a] Pair A, Pair B  Target pair of polymorphic markers for analysis 
[b] Allele count  The number of the summed Allele 
[c] LD coefficient  The displayed LD coefficients are D-value, D'-value, and r2-value. D’-95% CI is 

also displayed. (See section “11-(1) the haplotype block analysis”) 
[d] Statistics  The chi-square value, the degree of freedom, the p-value, and an AIC independent 

model (AIC (IM))-AIC dependent model (AIC (DM)) are selected as the values for 
evaluating LD and are displayed as the output. 

 
Notes   

1. In the case of AIC (IM–DM) > 0, the cell is displayed in blue. 
 
2. In the case of “p-value” is less than or equal to 0.05, the cell is displayed in red.  
 
 
 
 
 

 

[d] Statistics [b] Allele count 

  

Group tab 
In case of analysis by groups, the analysis result is displayed per group. Each group 
name (Selected in section “5-(2)”) appears on each tab. When a tab is clicked, the 
result of that particular group appears. 

  
[a] Target pair of polymorphic markers [c] Linkage disequilibrium coefficient 
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3. Bootstrap 
When using the Bootstrap method, bootstrap resampling techniques are performed to calculate the “Mean,” “SD,” and 
“95%CI.” 
 
<Explanation of the results of Chi-square test> 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The following statistics are obtained using the Bootstrap method: 
 
“D-Value,” “'D'-Value,” “r-square,” “Chi-Square,” “p-value,” and “AIC (IM-DM).”  

The results calculated using bootstrap resampling techniques 
are as follows: 
1. CI95%-Low : 95% confidence interval (Low) 
2. High  : 95% confidence interval (High) 
(The 2.5% and the 97.5% spots are shown for the case in 
which the results calculated using the bootstrap resampling 
techniques are sorted in ascending order. The iteration count 
was set in 8-(1) Parameter tab.) 
3. Mean  : the mean 
4. StdDev : the standard deviation
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 LD Map (Grid) window   
LD coefficient and statistics are output as an LD Map easily viewable. The results can be saved as a TSV file or 
an Excel file by clicking “Save” or “Save As” in File menu. 

 When saving the results as an Excel file, in order to view these results software which can open and view an 
Excel file must be installed beforehand. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

When you right click on the upper side window, a Pop-up menu appears. 
 
 
 
 

 
 

 Select LD Map type frame  
1. Group Comparative display of the results of two different groups. This can be used when 

analyzing two or more groups. 
 
2. Parameter Comparative display of the results of two different LD   
   coefficients and Statistics. In the case that only one was selected in 8-(1)  
   the Parameter frame, only the lower left triangle appears.   
 

Menu Description 
Copy Copy the selected area. 

Select All Select All. 

Hint 
In this window (LD Map (Grid)), altering the size of any one index cell will change the size of all cells at the same 
time. If you want to resize the column and row at the same time, hold down the shift key as you change the cell size. 
 
 

(2) 

(1)

Sub Group window 
A group of SNPs with strong Linkage disequilibrium group of SNPs appears. 

Select LD Map type frame 
Select a display style of the Linkage disequilibrium. 

LD map window (Grid style)  
Linkage Disequilibrium coefficient between SNPs appear. 
(1) Lower left triangle 
(2) Upper right triangle 
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1. Group 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
1. Information frame: 

 Parameter   
Select the LD coefficient or Statistic for output to the window.  
 

 Threshold dose  
The threshold for creating a Sub Group appears. This is the 2nd value in the lower 
left triangle frame. (See Notes (Sub Group)) 
 
 

2. Lower left triangle frame: 
 Group 

Select the group for display in the lower left triangle from the group names included 
in the subjects selected in section “8-(1)”. (Groups selected in section “5-(2)” are 
available.) 
 

 1st Value and 2nd Value 
Input the threshold for separating cells by color. The input content is not determined 
until the Enter key is clicked. A dialog for configuring the colors appears by double 
clicking on “Color” (Pink or Red); subsequently, the Background color can be 
changed. 

 
3. Upper right triangle frame: 

 Upper right triangle 
Check Upper right triangle when using the upper right triangle. 
 

 Group 
Select the group to be displayed in the upper right triangle from the group names 
included in the subjects selected in section “8-(1)”. (The groups selected in 5- (2) are 
available.) 

Information frame 
Select an LD coefficient or a Statistic for output. 

Lower left triangle frame 
Select the group to be displayed in the lower left triangle area, and the threshold 
value for separating cells by color, and the background color.  

Upper right triangle frame 
Select the group to be displayed in the upper right triangle area, the threshold 
value for separating cells by color, and the background color. This can be 
configured only when “Upper right triangle” is checked. 
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2. Parameter 
  
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
 
 

1. Information frame: 
 Group   

Select the group to be displayed from the group names included in the subject 
selected in section “8-(1)”. (Groups selected in section “5-(2)” are available.) 
 

 Threshold dose  
The threshold for creating a Sub Group appears. This is the 2nd value of the lower 
left triangle frame. (See Notes (Sub Group).) 
 

2. Lower left triangle frame: 
 Parameter 

Select the LD coefficient or Statistic for output to the lower left triangle.  
 

 1st Value and 2nd Value 
Input the threshold for separating cells by color. The input content is not determined 
until the Enter key is clicked. A dialog for configuring colors appears by double 
clicking on “Color” (Pink or Red); subsequently, the Background color can be 
changed. 

 
3. Upper right triangle frame: 

 Upper right triangle 
Check Upper right triangle when using the upper right triangle. 
 

 Parameter 
Select the LD coefficient or a Statistic for output to the upper right triangle.  

 
 1st Value and 2nd Value 

Input the threshold for separating cells by color. The input content not determined 
until the Enter key is clicked. A dialog for configuring the colors appears by double 
clicking on “Color” (Pink or Red); subsequently, the Background color can be 
changed. 

Information frame 
Select a group for output. 

Lower left triangle frame 
Select the LD coefficient or Statistic to be displayed in the lower left triangle 
area, and the threshold value for separating cells by color, and the back color.  

Upper right triangle frame 
Select the LD coefficient or Statistic to be displayed in the upper right triangle 
area, the threshold for separating cells by color, and the background color. This 
can be configured only when “Upper right triangle” is checked. 
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 Notes (Sub Group) 
Data value Cell background color

A data value < 1st value Nothing
1st value <= A data value < 2nd value Color (1st value)
2nd value <= A data value Color (2nd value)

 
 
 
 

 LD Map (BMP) window   
 LD Map (BMP) window does not appear when analysis is completed. It can be displayed by clicking the [LD- LD  

   Map (BMP)] index located on the Results tab in the Explorer window. The result can be saved as a BMP file by  
   clicking “Save” or “Save As” in the File Menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Select “LD Map type” frame 
1. Merge Comparative display of the results of two different groups when “Subject check box” 

is selected in the 8-(1). 
 
2. Group Comparative display of the results of two different groups when “Subject check box” 

is selected in the 8-(1). 
 
3. Parameter Comparative display of the results of two different LD coefficients and Statistics. 

(If only one parameter in the Data set up window is selected, only the lower left 
triangle will appear.) 

(2)

(1)

Group frame 
It is possible to select and change the color of each group. 

The Linkage disequilibrium range between 
SNPs can be displayed graphically. 

(1) Lower left triangle 
(2) Upper right triangle 

SNP sub groups with strong LD coefficients appear. 
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 1. Merge 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
1. Information frame:  

 Show Map Information 
     The information about LD coefficient and selected group appears in this window.  

 Triangle style 
Only the lower left triangle is drawn. 

 Base Color 
Select the Background color for the minimum data of LD coefficient or Statistics.  
Select White, Black and Thermal color. 

 Parameter   
Select the LD coefficient or a Statistic for output.  

 Pair A, Pair B 
The SNP Index of the cell that the cursor points to appears. 

 Threshold dose  
Display the threshold for creating a Sub Group. Change the threshold by moving the slider. Sub 
Groups are created from the Group1 data.  
 

2. Group1 frame:  
 Group  Select a group to be displayed from the group names included in the subjects 

selected in section “8-(1)”. (Groups selected in section “5-(2)” are available.) 
 Data  The combined data of Pair A and Pair B in this group appear. 
 Color scale  The degree of Linkage Disequilibrium is shown. By double clicking this, a Color 

Table dialog will appear. The scale color and scale color tone can be changed in this 
dialog box. 

 
3. Other Group frame:  

 Group  Select other group to be displayed superimposed on the group selected in the 
Group1 frame from the group names included in the subjects selected in section “8-
(1)”.  
(Groups selected in section “5-(2)” are available.) 

 Data  The combined data of Pair A and Pair B in this group appear. 
 Color scale  The degree of Linkage Disequilibrium is shown. By double clicking this, a Color 

Table dialog will appear. The scale color and scale color tone can be changed in this 
dialog. 

 
 
 

Information frame 
Select the LD coefficient or statistic for output. It is also possible to 
configure a display style and threshold for creating a Sub Group. 

Group1 frame 
Select a group to display its results. 

Other Group frame 
Superimpose display of the analysis result of two arbitrary groups. 
Select the second group by checking another group. 

 

 

Color scale 

Color scale 
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2. Group  
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
1. Information frame:  

 Show Map Information 
     The information about LD coefficient and selected group appear in this window.   

 Triangle style 
Only the lower left triangle is drawn. 

 Base Color 
Select the Background color for the minimum data of LD coefficient or Statistics.  
Select White, Black and Thermal color. 

 Parameter   
Select the LD coefficient or Statistic for output.  

 Pair A, Pair B 
The SNP Index of the cell that the cursor points to appears. 

 Threshold dose 
Display the threshold for creating a Sub Group. Change the threshold by moving the slider. Sub 
Groups are created from the Group1 data. 

 
2. Lower left triangle frame:  

 Group Select a group that you wish to display in the lower left triangle from the group 
names included in subjects selected in section “8-(1)”. (Groups Selected in section 
“5-(2)” are available.) 

 Data   The combined data of Pair A and Pair B in this group appear. 
 Color scale The degree of Linkage Disequilibrium is shown. By double clicking this, a Color 

Table dialog will appear. The scale color and scale color tone can be changed in this 
dialog box. 

 
3. Upper right triangle frame:  

 Group  Select a group to be displayed in the lower left triangle    
   from the group names included in the subjects selected in 8- (1). 
   (Groups selected in section “5-(2)” are available.) 

 Data   The combined data of Pair A and Pair B in this group appear. 
 Color scale The degree of Linkage Disequilibrium is shown. By double clicking on this, a Color 

Table dialog will appear. The scale color and scale color tone can be changed in this 
dialog box. 

 

 

 

 

 

Information frame 
Select the LD coefficient or Statistic for output. It is also possible to 
configure a display style and threshold value for creating a Sub Groups. 

Group1 frame 
Select a group to display its results. 

Other Group frame 
Superimpose display of the analysis result of two arbitrary groups. 
Select the second group by checking another group. 
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3. Parameter 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
1. Information frame:  

 Show Map Information   
      The information about LD coefficient and selected group appear in this window.  

 Triangle style  
Only the lower left triangle is drawn. 

 Base Color 
Select a Background color for the minimum data of the LD coefficient or Statistics.  
Select White, Black and Thermal color. 

      Group 
Select the group to be displayed from the group names included in the subjects selected in section “8-
(1)”. (Groups selected in section “5-(2)” are available.) 

 Pair A, Pair B 
     The SNP Index of the cell that the cursor point to appears. 

 Threshold dose  
Display the threshold for creating a Sub Group. Change the threshold by moving the slider. Sub Groups 
are created from the lower left triangle data. 
 

2. Lower left triangle frame:  
 Parameter      Select a LD coefficient or Statistic for output to the lower left triangle.  
 Data  The combined data of Pair A and Pair B in this group appear. 
 Color scale  The degree of Linkage Disequilibrium is shown. By double clicking on this, a Color 

Table dialog will appear. The scale color and scale color tone can be changed in this 
dialog box. 

 
3. Upper right triangle frame:  

 Parameter      Select a LD coefficient or Statistics for output to the upper right triangle 
 Data  The combined data of Pair A and Pair B in this group appear. 
 Colors scale  The degree of Linkage Disequilibrium is shown. By double clicking on this, a Color 

Table dialog will appear. The scale color and scale color tone can be changed in this 
dialog. 

 
 
 
 
 
 

Information frame 
Select a group or the threshold value for output. It is also possible to configure 
the display style and the threshold value for creating Sub Groups. 

Lower left triangle frame 
Configure an LD coefficient or Statistics for display in the lower left 
triangle. 

Upper right Group frame 
Select an LD coefficient or a statistic for display in the upper right triangle. 
Only in the case of checking the upper right triangle can this be configured. 
 

Color scale  

Color scale  
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9. Haplotype Inference 
SNPAlyze estimates haplotype frequencies of each group using the Expectation-Maximization algorithm (EM 
algorithm), individual combinations of haplotypes (diplotype), and the most frequently occurring haplotype in all groups. 
 

 Process 
(1) Select the objective Polymorphic markers and configure the analysis conditions.  
Click “Haplotype Inference” in the Analysis menu. The Data Setup dialog box appears. 
 

 Select Locus tab 
1. Selection of Polymorphic markers 

Polymorphic markers selected in section “5-(2)” are displayed in the “Selected” list box. These markers can 
be moved between the Removed list box and the Selected list box using the     and     button. 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Selection of subject  
In the case of analysis by groups, it is necessary to select the subject that includes group information. Please 
check “Subject.” You can select a subject index that was registered in section “5-(1)”. If you registered 
several subjects, please select one of them. (Only subject indexes selected in section “5-(2)” from the group 
information included in the selected subjects are used.) 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Removed list box: 
The Polymorphic markers that 
are not selected for analysis are 
displayed. 

Selected list box: 
Objective polymorphic markers for analysis selected 
in section “5-(2)” are displayed. 

Subject combo box: 
Display the subject index registered at section “5-(1)”. 
In the case of analysis by groups, select the subject that 
includes group information. 

Sheet tab: 
These tabs correspond to the page number of the data 
sheets. Polymorphic markers contained in the selected 
sheet are displayed. 
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 Parameter tab 
Configure the analysis conditions. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
1. EM algorithm frame 

 Iteration Counter 
Select the maximum number of iterations. (Initial value is 1,000.) 

 Conversion Criterion  
Select a value of the Criterion to terminate the estimation by the EM algorithm. (Initial value is 1.0E–7.) 

 Censored data check box 
If checked, SNPAlyze estimates all haplotype frequencies except for those haplotypes whose frequencies are less 
than the specified value. (Enter the threshold into the adjacent text box.) 

 Take account of missing Genotypes check box 
   If checked, SNPAlyze estimates haplotype frequencies considering missing data included in the sheets. (Characters  
   in the data sheets must define missing data.) 
 
2. Bootstrap frame 
If you wish to use the Bootstrap method, check the Bootstrap check box. The number of iterations available in the 
Bootstrap method ranges from 100 to 10,000. (Initial value is 1,000.) 
 
3. Diplotype Matrix check box 
The distribution of diplotypes calculated in the process that presumes Haplotype frequency using the EM algorithm is 
displayed. If checked, the diplotype distribution window appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Bootstrap frame: 
If you wish to use the Bootstrap method, check the “Bootstrap” 
check box. 

EM algorithm frame: 
Set the maximum number of iterations, convergence 
condition at the end of the replication, and treatment 
of missing data. 
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 Configuration tab 
If the number of SNPs exceeds 20, the results are not displayed but are automatically saved as a TSV file. (At the end of 
the analysis, the results are saved as the specified text file.) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
1. Haplotype Data frame 
When the haplotype frequency data is required to be saved, check “Haplotype Data” and click the Browse button; 
specify or create a file path and a file name. 
 
2. Diplotype Matrix Data frame 
When the Diplotype distribution data is required to be saved, check the “Diplotype Matrix Data” check box and click 
the Browse button; specify or create a file path and a file name. 

 
 Check “Haplotype Data” if the number of SNPs is 20 or less, the results are not displayed but automatically  

   saved as a file.  
 

 Click the “OK” button when you finish configuring this dialog box. Results will be displayed. You can quit the 
analysis process at any time by clicking the “Cancel” button. 
*The results can be displayed only if the number of iterations is more than 100 when you quit the analysis during the 
execution of the “Bootstrap method.”  
*Results are available when the “Cancel” button is clicked only when using the Bootstrap method. 

Haplotype Data frame 
A file path to save the results, haplotype candidates, and 
the haplotype frequencies in each Group appears. 

Diplotype Matrix Data frame 
A file path to save the diplotype distribution data appears. 
 

Click the Browse button, and specify a file path. 
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(2) Explanation of the results 
 

 Haplotype Data window 
  SNPAlyze estimates the haplotype candidates and haplotype frequencies in each Group. In addition, it is possible to  
  output the individual combinations of haplotypes (diplotype) estimated and judged as the maximum likelihood phase  
  by the EM algorithm. Results can be saved as a TSV file or an Excel file by clicking “Save” or “Save As” in the File  
  menu. 
   In the case of an Excel file, the number of haplotype candidates in each Group must be 10,000 or less. If  

  the number of haplotype candidates exceeds 10,000, the results can only be saved as a TSV file. 
   When saving the results as an Excel file, in order to view these results software which can open and view an 

Excel file must be installed beforehand 
   If the number of haplotype candidates exceeds 400,000, the analysis is not possible. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Menu Description 
Resize The cell size change to fit all cells into this window. 
Default The cell size returns to the original size. 
Color Table  The haplotype information window appears. 

When you right click on a grid, a Pop-up menu appears. 

Group tab 
In the case of analysis by groups, the analysis result is displayed per 
group. When you click the group name (Selected in section “5-(2)”) 
that appears in the tab, its result appears. 

htSNP (tagSNP) 
The cells containing defined tagSNP are highlighted 
in red and are displayed with an asterisk. 

Haplotype candidates in a group and its 
frequencies are computed. 

The diplotype of each sample is outputted. 
The number of entries in the “Haplotype 1” 
and “Haplotype 2” columns is equivalent to 
a Haplotype No. in the upper window. 
 

 The diplotype displayed here is judged 
as the maximum likelihood by the EM 
algorithm. 

The results calculated using bootstrap resampling techniques 
are as follows: 
1. CI95%-Low : 95% confidence interval (Low) 
2. High  : 95% confidence interval (High) 
(The 2.5% and the 97.5% spots are shown for the case in 
which the results calculated using the bootstrap resampling 
techniques are sorted in ascending order. The iteration count 
was set in section “9-(1) Parameter tab.”) 
3. Mean  : the mean 
4. StdDev  : the standard deviation  



48
Copyright (C) 2008 All rights reserved by Dynacom Co., Ltd. 

 

 
 
 
 
 
 
 
 
 
 
 

 
 

1. SNP allele frame 
Major allele Select the Cell color for the Major allele. If the color (Blue) is double 

clicked, a Set up color dialog appears. The background color can be 
changed. 

Minor allele  Select the Cell color for the Minor allele. If the color (Red) is double 
clicked, a Set up color dialog appears. The background color can be 
changed. 

 
2. Microsatellite frame 

High frequency Select the Cell color for the highest frequency allele. If the color (Blue) 
is double clicked, a Set up color dialog appears. The background color 
can be changed. 

Middle frequency Select the Cell color for the middle frequency allele. If the color 
(Purple) is double clicked, a Set up color dialog appears. The 
background color can be changed. 

Low frequency Select the Cell color for the lowest frequency allele. If the color (Red) is 
double clicked, a Set up color dialog appears. The background color can 
be changed. 

 
The background colors of other alleles are automatically created depending on the background 
color specified by “High frequency” and “Low frequency”. 

 
3. Mask frame 

Select the Cell color for the haplotype data the frequency of which is less than 1 / (2 × N).  
If the color (Gray) is double clicked, a Set up color dialog appears. The background color can be 
changed. When Mask is not selected, infrequent-haplotype frequency is distinguished by the 
background color of the Major and Minor allele. 

 
 Diplotype Matrix window 

  The distribution of diplotypes calculated in the process that estimates Haplotype frequencies by the EM algorithm is  
  displayed. The results can be saved as a TSV file or an Excel file by clicking “Save” or “Save As” in the File menu. 
 

 When the number of haplotype candidates is greater than 200, the Diplotype estimated with the top 200 
haplotype candidates according to their corresponding frequencies are displayed. 
 

 When saving the results as an Excel file, in order to view these results software which can open and view an 
Excel file must be installed beforehand 

SNPs allele frame: 
Select cell colors for the major allele 
and the minor allele. 

Microsatellite allele frame: 
Select cell colors for Microsatellite alleles. 

Haplotype information window 

Mask frame: 
Select cell color for the low frequency 
haplotype. 
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Menu Description 
Resize The cell size changes to fit all the cells into this window. 
Default The cell size returns to the original size. 

When you right click on the grid, a Pop-up menu appears. 

Distribution of diplotype 

The number of an Index row and an Index 
column are equivalent to a Haplotype 
candidate's number obtained as a result of 
performing the Haplotype estimation. 

Group tab 
In the case of analysis by groups, the analysis result is displayed per 
group. When you click the group name (Selected in section “5-(2)”) 
that appears in the tab, its result appears. 

Color Information frame 
Specify a color tone for the Diplotype distribution level. 

Haplotype Information frame 
The combination of the Haplotype that constitutes the Diplotype 
of the cells selected with the cursor and the number of samples 
with the same diplotype, are displayed. 

 Diplotype Information frame 

 Color Information frame 

Adjust the color tone by dragging the sliders of red 
color, green color, and blue color. 

Haplotype 1 This is one haplotype of the diplotype. 
Frequency  This is the “Haplotype 1” frequency. 

Haplotype 2 This is one haplotype of the diplotype. 
Frequency  This is the “Haplotype 2” frequency. 

Specify a color tone for the Diplotype distribution level. 

Diplotype This is the sum of the Samples that belongs to 
the diplotype. 
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 Haplotype detail information window 
If you perform multilocus haplotype inference, two or more combination of htSNP may exist. SNPAlyze output all 
possible sets and htSNP (tagSNP) combinations were displayed in a “Haplotype detail information” window. This 
window shows haplotype frequencies and diplotype information as well as htSNP combinations. 

 
The results can be saved as a TSV file by clicking “Save” or “Save As” in the File menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

For reference) Result of haplotype inference and htSNP (tagSNP) combinations.
 
1. Result of Haplotype inference 
 

 
 
2. htSNP (tagSNP) information 
 

Before Ver.5.1  (Number of combination -> 1) 
tagSNP-1  SNP-1   SNP-4 SNP-5 
 
Ver.5.1 or later  ( Number of combinations  -> 3) 

tagSNP-1  SNP-1   SNP-4 SNP-5 
tagSNP-2         SNP-2           SNP-4 SNP-5 
tagSNP-3    SNP-3   SNP-4 SNP-5 

Basic information 

All the possible htSNP combinations 
are outputted. 

Haplotype frequencies and htSNPs 
are outputted. 

EM algorithm setting 

Click on the item. The detail information 
is displayed in the right-hand window. 

The diplotype of each sample is outputted.  
 The diplotype displayed here is judged 

as the maximum likelihood by the EM 
algorithm 
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10. Case-Control Haplotype Analysis (The Permutation test) 
The difference between haplotype distributions of Groups can be obtained by this analysis. The significance of the test 
results is evaluated by the Permutation test. 
 

 Process 
(1) Select the objective Polymorphic markers and configure the analysis conditions.  
Click “Case-Control Haplotype Analysis” in the Analysis menu. The Data Setup dialog box will appear. 
 

 Select Locus tab 
1. Selection of Polymorphic markers 

Polymorphic markers selected in section “5-(2)” are displayed in the “Selected” list box. These markers can 
be moved between the Removed list box and Selected list box using the     and     button. (The 
maximum number of SNPs that can be simultaneously analyzed is 10.) 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
 
2. Selection of subject  
In the case of analysis by groups, it is necessary to select the subject that includes group information. Please 
check “Subject”. You can select a subject index that was registered in section “5-(1).” If you registered several 
subjects, please select one of them. (Only subject indexes selected in section “5-(2)” from the group information 
included in the selected subjects are used.) 

 
 

 
 
 
 
 
 
 
 
 
 
 

Removed list box: 
The Polymorphic markers that are not selected 
for analysis are displayed. 

Selected list box: 
Objective polymorphic markers for analysis selected 
in section “5-(2)” are displayed. 

Sheet tab: 
These tabs correspond to the page number of the data 
sheets. Polymorphic markers contained in the selected 
sheet are displayed. 
 

Subject combo box: 
Display the subject index registered in section “5-(2).” 
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 Permutation test tab 

Configure the analysis conditions. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1. Parameter frame 

 Statistics Select the Statistics for use in Permutation test. It is possible to select either Chi-square or AIC. 
 Number of replicates  

Select or input the number of Permutations. The number of available Permutations ranges from 100 to 10,000. 
(Initial value is 1,000.) 

 Number of decimals 
Select a decimal point of the “p-value” and “permutation p-value” output.  

 Each haplotype check box 
The “permutation p-value” of each haplotype will be outputted. 

 Pool low frequency haplotypes 
If this is checked, SNPAlyze tabulates the low frequency haplotypes, and they are evaluated as one group of 
haplotype. 

 Refer to section “14-(3) Permutation test” for more information on Support Documentation. 
 
2. Approach frame 

 Haplotype Inference  
   The Permutation test is executed on samples. A series of processings that tabulate a contingency table from  
     estimated haplotype numbers are repeatedly performed. 

 Contingency table 
   The Permutation test is executed on a contingency table tabulated from estimated haplotype numbers. 

 Refer to section “14-(3) Permutation test” for more information on Support Documentation. 
 
3. Chart frame 

 Cumulative (Left tail) check box 
Cumulative frequency distribution of the Statistics for which each Permutation test is outputted. 

 Distribution check box 
   Frequency distribution of the Statistics for which each Permutation test is outputted.  

 
 
 
 
 
 
 
 

Chart frame: 
Setting the types of charts that show the results of the 
Permutation test. 

Parameter frame: 
Setting the values and conditions for the Permutation 
test (Statistics, iteration number, convergent conditions, 
etc.) 

Approach frame: 
Selecting the subject to which the Permutation test will 
be applied. 
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 EM algorithm tab  
Configure the analysis conditions. 

 

 

 

 

 

 

 

 

 

 

 
 
 
1. Parameter frame 

 Iteration Counter    
   Select the maximum number of iterations. (Initial value is 1,000.) 

 Conversion Criterion  
   Select a value of the Criterion to terminate the estimation by the EM algorithm. (Initial value is 1.0E–7.) 

 Censored data check box 
   If this is checked, SNPAlyze estimates the haplotype frequencies except the haplotype whose frequencies are less  

   than the specified value. (Enter the threshold into the next text box.) 

 Take account of missing Genotypes check box  

   If this is checked, SNPAlyze estimates the haplotype frequencies by considering the missing data included in the  

   sheets. (Characters in the data sheets must define the missing data.) 
 
 

 Click the “OK” button when you finish configuring this dialog box. Results will be displayed.  
       If you click the Cancel button in the middle of the analysis, the analysis ends halfway, and the halfway results  
       will be displayed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Parameter frame: 
Set up the maximum number of iterations, the convergence 
condition at the end of the replication, and whether to treat 
missing data. 
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(2) Explanation of the results 

 
 Permutation test tab 

Haplotype frequency and the Permutation test results estimated from each group configured in section “10-(1) Subject” 
and the entire group is outputted. The results can be saved as a TSV file by clicking “Save” or “Save As” in the File 
menu. 
 
  
 
 
 
 
 
 

 

 

 

 
 
 
 
  
 
 
 
 
 
 
 
 
 
The Permutation test results (1) are as follows. 

 Chi-Squ The Chi-square value that is calculated from the original data set (not the permutated 
data set.) 

 p-value  Upper Probability (In case of AIC, this is not outputted.) 
 Permutation p-value p-value based on Permutation test. 
 Upper  The number of times that the Statistical value of each Permutation test is greater 

than the original value for all Permutation test (Chi-Squ). 
 Done  The iteration number of Permutation test/the number of Permutation test. 

 
The Permutation test results (2) are as follows. 

 Chi-Squ The Chi-square value that is calculated from the original data set (not the permutated 
data set.) 

 p-value  Upper Probability (In case of AIC, this is not outputted.) 
 Permutation p-value p-value based on Permutation test. 

 
 

 A statistic used in the Permutation test (For example, “Chi-Squ” in the above figure) is selected from “Statistics” in  
the Permutation test tab (1). 
  

 The Upper Probability is computed after excluding the haplotypes that have a frequency less than “1/2n” (“n” is  
number of samples) of each group. 

 

Haplotype frequency in all groups. 

Haplotype frequency classified by groups. 

Haplotype candidates are outputted. 

Permutation test result (1) 
The selected polymorphic marker Indexes 
selected in 10- (1) appears in the “Select locus” 
Column. The markers of each Haplotype 
candidate are arranged in this order. Permutation test result (2) 

This result appears when each haplotype 
checkbox in a Permutation test frame is 
checked. The iteration count is identical 
to the Permutation test result (1) “Done.” 



55
Copyright (C) 2008 All rights reserved by Dynacom Co., Ltd. 

 

 
 

 Contingency table tab 
All the results of Case-Control Haplotype Analysis are outputted here. The outputted data may be saved in rich text 
format or text format. 

 
The output items are as indicated below. 

1. Haplotype Inference 
 Setting the EM algorithm parameter. 

(Contents set with 10- (1) EM algorithm tab) 
 Haplotype frequency for every group. 

 
2. Permutation test 

 Setting the Permutation test parameter. 
(Contents set with section “10- (1) Permutation test tab/Parameter frame”) 

 Results of the Permutation test evaluated with the entire haplotypes 
Display of contingency table and calculation results. 

 Results of the Permutation test evaluated with any haplotype  
(If you selected the section “10- (1) Permutation tab/Parameter frame/Each haplotype check 
box”) Display of the contingency table and calculation results. 

 
 3. List of output estimators 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
* Displayed only when evaluating Permutation test for each haplotypes. 
** Displaying the number of difference between the Df of contingency table obtained from original data 
and from the resampling process. 

 
 
 

10-(1) Permutation tab / Parameter frame ./ Statistics  

Chi-square AIC 
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•  Chi-square 
•  Df (degrees of freedom) 
•  p-value 
•  Permutation p-value 
•  Probability (contingency table) 
•  Lower 
•  Done 
•  Fisher’s exact test * 
•  Odds ratio 
•  Woolf’s CI95%-Low 
•  Woolf’s CI95%-High 
 

•  AIC(IM-DM) 
•  Permutation p-value 
•  Probability (contingency table) 
•  Lower 
•  Done 
•  Fisher’s exact test * 
•  Odds ratio 
•  Woolf’s CI95%-Low 
•  Woolf’s CI95%-High 
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e •  Chi-square 

•  Df 
•  p-value 
•  Permutation p-value 
•  Upper 
•  Done 
•  Df changes ** 

•  AIC(IM-DM) 
•  Permutation p-value 
•  Upper 
•  Done 
•  Df changes ** 
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Chart tab 
If the cumulative check box or distribution check box in the Chart frame in the Parameter tab is checked, these  
results will appear. Frequency distribution data can be saved as a TSV file by clicking “Save” or “Save As” in the  
File menu. Chart data can be saved as a BMP file by clicking “Save Chart” in the File menu. 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

 
 
 

 By right clicking on this chart, a Chart Information window will appear. 
 
 

 Chart Information window 
 Chart tab: It is possible to specify a labeling method and display an explanatory note. 

 
 
 

 
 
 
 
 

 
 Series tab: It is possible to specify the series color (inside, rim), change, and display/no. of displays,. Further, the data  

   of only one series can be displayed by deleting the data of the other series. 
 

 
 
 

Frequency distribution of the statistics 
The frequency distribution of the statistics appears.

Display an explanatory note.

The method of displaying 
Chart is selected. 

Color frame 
Inside    Specify the series inside color. 
Edge/Line    Specify the rim of a series color. 

Option frame 
Hide    Specify not to display a series. 
Exclude    Specify to exclude a series. 

Select a series. 

Chart  
A frequency distribution graph is obtained from the frequency distribution of calculated 
Statistics. The display of an accumulated value is also possible. By right clicking on 
this chart, a “Chart Information” window will appear. It is possible to specify the bar 
color and display an explanatory note in the Chart Information window. 
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11. Haplotype Block Analysis 
The area with strong linkage between polymorphic markers is defined as a haplotype block. SNPAlyze can use the 
Gabriel method and the Four-Gamete method as a general method for haplotype block construction. 
* note: estimation of a haplotype block can be applied only to SNP-type polymorphic markers. Please note that the 
microsatellite type markers are not applicable. 
 

 Process 
(1) Select the objective Polymorphic markers and configure the analysis conditions.  
Click “Haplotype Block Analysis” in the Analysis menu. The Data Setup dialog box will appear. 
 

 Select Locus tab 
1. Selection of Polymorphic markers 

Polymorphic markers selected in section “5-(2)” are displayed in the “Selected” list box. These markers can 
be moved between the Removed list box and Selected list box using the     and     button. (The 
maximum number of SNPs that can be simultaneously analyzed is 1000.) 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
 
 

 
 

 
 

 
 
 
 
 
 
 
 

Sheet tab: 
These tabs correspond to the page number of the data 
sheets. Polymorphic markers contained in the selected 
sheet are displayed. 
 

Removed list box: 
The Polymorphic markers that are not selected 
for analysis are displayed. 
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2. Selection of subject  
In the case of chi-square test for each haplotypes, it is necessary to select the subject that includes group 
information. Please check the “Subject” check box. You can select a subject index that was registered in section 
“5-(1)”. If you registered several subjects, please select one of them. (Only subject indexes chosen in section “5-
(2)” from the group information included in the selected subjects are used.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Subject combo box: 
Display the subject index registered in section “5-(2).” 
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 Parameter1 tab 
Configure the analysis conditions of Gabriel method. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Gabriel method frame 
Set a D’-CI and a minor allele frequency as the selection criteria for construction of a haplotype block using the Gabriel 
method. 

 D’-CI for strong LD 
Upper: The upside value in a D'-95% CI. 
Lower: The downside value in a D'-95% CI. 
Construct a block by using strong LD where a D’-95% CI between the markers is within the above-mentioned 
range. 

 Minimum r2 for strong LD check box 
Check here when setting a threshold value at an r2-value in addition to a D’-95% CI. The threshold value can be 
arbitrarily changed.  

 Maximum upper D’-CI for strong recombination 
Do not judge it as strong LD when the Upper is below this value, even if a D’-95% CI ranges between Upper and 
Lower.  

 Maximum strong LD ratio in a Haplotype Block 
Set the ratio of strong LD and recombination as the judgment criterion for constructing a block.  

 Minimum MAF for effective markers 
   Exclude the markers with a minor allele frequency below this value. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gabriel method frame: 
Set the selection criterion for construction of a 
haplotype block using the Gabriel method. 
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Paramter2 frame 
Configure the analysis conditions in haplotype inference. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Haplotype Inference frame 

 Censored haplotypes [%] 
   SNPAlyze estimates the haplotype frequencies except the haplotype whose frequencies are less than the specified  

   value. (Enter the threshold into the next text box.) 
 Take account of missing Genotypes check box 

   If this is checked, SNPAlyze estimates the haplotype frequencies by considering the missing data included in the  

   sheets. (Characters in the data sheets must define the missing data.) 
 

 
 Click the “OK” button when you finish configuring this dialog box. Results will be displayed.  

       If you click the Cancel button in the middle of the analysis, the analysis ends halfway, and the results  
       will not be displayed. 
 

(2) Explanation of the results 
 
   Result window 
    A block constructed by SNP markers used for the analysis and haplotype candidates in the block are displayed.  
    Only haplotype candidates with a frequency higher than that set in the 11-(1) Parameter2 tab are displayed.  
    Moreover, the SNP tag in the haplotype block is also displayed simultaneously.  
    If you check the “Subject”check box in section 11-(1), results (p-value) of chi-square tests for each haplotype      
    will also appear. These results are equivalent to those which would be obtained from “Case-control haplotype      
    analysis” with select “Haplotype Inference” option at Approach frame in the 10-(1) Permutation test tab.  
    Results can be saved as a TSV file or an Excel file by clicking “Save” or “Save As” in the File menu. 
 

 When saving the results as an Excel file, in order to view these results software which can open and view an      
   Excel file must be installed beforehand. 

 
 

 

 
 

Haplotype Inference frame: 
Set the conditions for the haplotype inference when a 
haplotype block is constructed. 
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[a] Selection of the method for constructing a block. 
Select the method for constructing a haplotype block in the combo box of “Method.” 

*Gabriel: The method for selecting D'-95% CI as the selection criterion. (Gabriel et al, science., 2002) 
*Four Gamete: The method for selecting a non-recombinant area as the selection criterion.  

(Wang et al, Am.J.Hum.Genet., 2002) 
*User: User definition of a block. 
 
 
[b] Block information 
The length of each block is displayed. Moreover, Case-Control Haplotype Analysis (permutation method) can be 
executed by using markers which construct each Haplotype Blocks, as shown in the following figure. (It is necessary 
to registrate the populations in section “5-(1)”.) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

  
 

1. Select a haplotype block as the subject. 
 
2. Click the "Permutation Test…" button. 
 
3. The dialog box shown on “10-(1) setting up analysis 
conditions-Data Setup” opens. * Please refer to.section 
“10. Case-Control Haplotype Analysis.” 
 
4. Using the same procedure, Hardy-Weinberg 
Equilibrium tests, Case-Control studies, and 
Haplotype Inferences can be executed from the 
“Analysis” menu. 
 

[b] Block information 
[a] Selection of the method for 
   constructing a block. [d] Frequency between  

   two Haplotype Blocks 
[c] Haplotype Block 
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[c] Haplotype Block 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
*Haplotype candidates: Haplotype candidates and their frequencies in a block are the output.  
 (Haplotype candidates with frequencies below the specified set at “11-(1) Parameter2” value in are not displayed.) 
*htSNPs, (tagSNP): htSNP (tagSNP) in a block is displayed in color. 
*p-value from chi-square test: Results (p-value) of chi-square tests for each haplotype will appear. These results are 
equivalent to those which would be obtained from “Case-control haplotype analysis” with select “Haplotype Inference” 
option at Approach frame in the 10-(1) Permutation test tab.  
*Frequency between two Haplotype Blocks: LD coefficients among blocks (D’-value) are displayed 
 
 
[d] Frequency between two Haplotype Blocks 
 
The combination and the frequency are displayed 
when a long haplotype is formed from the connection of  
each haplotype between blocks. 
For example, a long haplotype is formed from the  
connection of “haplotype candidate 1 in Block 1”  
and “haplotype candidate 1 in Block 2,” and its  
frequency is 0.3776. 
 

*occurrence rate1: Connections of haplotypes with  
             frequencies exceeding 0.1 are displayed  
             with a thick line. 
 
*occurrence rate2: The number at left end shows the  
             left-hand side haplotype number,  
             while the number at right end shows  
             the right-hand side haplotype number;  
             the center display shows the frequency. 
 

 

 Haplotype candidates Frequency between two Haplotype Blocks (D’ value) htSNP (tagSNP) 

p-value from chi-square test 
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   LD Map window 
    This window is essentially the same as that shown in “8-(2) LD analysis-LD Map (Grid)” and the yellow  
    area shows a haplotype block. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
[a] Selection of the block construction method. 
Select a block constructing method using the same procedure as that used for a result window. 

[b] Haplotype Block 
An area corresponding to a haplotype block is displayed in yellow. 

 

 User definition of a haplotype block 
On a LD Map screen, a haplotype block can be arbitrarily constructed. All the operations are executed by using a right-
click menu. 
*Right-click on the grid screen displays a pop-up menu. 

 

 

 

 

Menu Description 
Copy Copy the selected area. 

Select All Select All. 

Set  Set up a new block. 
Clear Delete a block. 
Join Connect existing blocks. 

[a] Selection of the block 
construction method. 

[b] Haplotype Block 
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*Add a block. 
   Drag a range to add. Select “Set” in the right-click menu. Clicking “Set” on the area with a block will delete the     
   block and only the selected area will become a block. 
 
*Delete a block. 
   Drag a range to delete. Select “Clear” in the right-click menu. 
 
*Join a block. 
   Drag a range to add. Select “Clear” in the right-click menu. The execution of the operation in the area with a block  
   will result information of a new block, including the existing block. 
 
 

 (e.g.) In the case of adding a new block by user definition. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
   LD Pairwise window 

This window is similar to the window output shown on ”8-(2) LD analysis-Pairwise Data.” 

 Drag the area to form a block. Select “Set” in the right-click menu. 

Click “Apply” button. 
The results are displayed in the result window. 
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12. Cluster Analysis 
SNPAlyze is capable of running the cluster analysis by considering the calculated Statistical values from case-control 
studies. 
 

 Process 
(1) Selection of Statistical values and configuration of the analysis conditions 
 1. Click “Cluster Analysis” in the Analysis Menu. The Data Setup dialog box will appear. 

Select objective Statistics from the Removed list and click the     button to add them to the Selected list box. 
Click the Dissimilarities tab. Conversely, the data that are displayed in the “Selected” and “Subject” list boxes 
can be moved to the “Removed” list box by clicking the     button. 

 
 
 
 
 
 
 

 
 
 
 
 
 
 

 Dissimilarities  Select a method for calculation of dissimilarity (the distance.) 
 Methods   Select a method for cluster analysis.  

 
 

    
 
 
 
 
 

 
 
 
 
 

 Click the “OK” button when you finish configuring this dialog box. The analyses results are displayed. 
 

Select target 

Click Methods tab 
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(2) Explanation of the results  
 
            

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Dendrogram window 
 A dendrogram appears. The analysis result can be saved as a BMP file. 

 
 Dissimilarity Matrix window 

 A dissimilarity matrix appears. The analysis result can be saved as a TSV file. 
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The methods used by SNPAlyze for calculation of dissimilarity and cluster analysis are as follows.  
(Initial values are “Euclidean square distance” and “Ward-Method,” respectively.)  
 

 The method for calculation of dissimilarity (the distance) 
 
 
 
 
 
 
 

 The method for cluster analysis 
 
 
 
 
 
 
 
 
 
 
 

Notes 
When the dissimilarity between clusters is very big, a small cluster does not appear. In this case, select “Square” so 
that the dendrogram is drawn in consideration with the Square value between clusters. 

SQUARED EUCLIDEAN SQUARED EUCLIDEAN DISTANCE 
Standardized squared 

euclidean Standardized Squared Euclidean Distance 

Mahalanobis Mahalanobis' Generalized Distance 

NEAREST NEIGHBOR NEAREST NEIGHBOR METHOD 
(SINGLE LINKAGE METHOD) 

Furthest neighbor Furthest neighbor method 
(Complete linkage method) 

Group average Group average method 
Centroid Centroid method 
Median Median method 
Ward Ward method 

 Process window 
 A process to plot a dendrogram appears. The results can be saved as a TSV file. 
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13. Logistic Regression Analysis 
 
HealthSketch V2.5 or after is required! 
 
Cooperate with HealthSketch, SNPAlyze performe logistic regression analysis for each SNP. You can calculate Odds 
Ratio (OR), 95% Confidence Interval of the OR and p-value of likelihood ratio test for Dominant, Recessive and 
Genotype model about each SNP.  

 
  

 Process 
(1) Select the objective polymorphic markers and configure the analysis conditions. 
Click “Logistic Regression” in the Analysis menu. The Data Setup dialog box will appear. 
 

 Select Locus Tab 
1. Selection of Polymorphic markers 

Polymorphic markers selected in section “5-(2)” are displayed in the “Selected” list box. These markers can be 
moved between the Removed and Selected list boxes, using the     and     buttons. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

 
 
 

Removed list box: 
The Polymorphic markers that 
are not selected for analysis are 
displayed. 

Sheet tab: 
These tabs correspond to the page number on the data 
sheets. The Polymorphic markers contained in the selected 
sheet are displayed. 

Selected list box: 
Objective polymorphic markers for analysis selected 
in section “5-(2)” are displayed. 
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2. Selection of subject  
Please check the “Subject” check box. You can select a subject index that was registered in section “5-(1).” If 
you registered several subjects, please select one of them. (Only the subject indexes selected in section “5-(2)” 
from the group information included in the selected subjects are used.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(2) Explanation of the results 
The overall results and the statistical value of ach group are shown. 
The results can be saved into a TSV file and Excel file by clicking “Save” or “Save As” in the File menu. 
  

 Statistics window 
Displaying the statistics data that calculated from Dominant, Recessive and Genotype model about each SNP. Odds 
Ratio (OR) , 95% Confidence Interval (CI) of the OR and p-value of likelihood ratio test are outputted. (In 
Genotype model, OR and 95% CI of the OR are outputted for Heterozygote and Minor allele homozygote. 

Subject combo box: 
Display the subject index registered in section “5-(2).” 

Analysis results of Genotype model (Heterozygote) 
Scroll the viewing area of the window, analysis results of Genotype 
(Minor allele homozygote), Recessive, Dominant model will be 
displayed. 
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 Details information window 
 Details window does not appear when analysis is completed. It can be displayed by clicking the [Logistic   

Regression Analysis- Detail information] index located on the Results tab in the Explorer window. 
The results can be saved into a TSV file and Excel file by clicking “Save” or “Save As” in the File menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click on the marker name 
to browse the results. 

Basic information 

Display maximum likelihood settings 

Sample tabulation results and following statistical values are computed in each model. 
 Control (0) the amount of Control data. 
 Case (1)     the amount of Case data. 
 Odds ratio  Odds Ratio 
 CI95%-Low 95% confidence interval (low) 
 CI95%-High   95% confidence interval (High) 
 AIC  Akaike’s information criterion 
 p-value   p-value of likelihood ratio test 

Error message information 
Error occurred while logistic regression analysis.  
The following error messages will be displayed in the Detail information window.  
 

Error messages 

There is a factor with only all the same values. 

A solution of the method of maximum likelihood did not converge. 

Logistic regression is available only for bi-allelic marker. 
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14. Support Documentation 
 
(1)Warning messages 
  The warning messages that can be set to be displayed or suppressed are as follows: 
 
  “There is no subject column. Please select from following list” 
  Displayed when you start an analysis without entering the Subject information. 
 
  “Please select polymorphic markers for analysis from following list” 
  Displayed when you start an analysis without entering the Data information 
 
  “Notice!! It's not clear that LD exists between Microsatellite markers. Be aware that your results may be  
   incorrect. Refer to SNPAlyze manual for further information” 

 Displayed when you are dealing with Microsatellite data in a Linkage disequilibrium  
   analysis. Refer to section 14-(2) of the Support Documentation, “Linkage disequilibrium in  
   Microsatellite” for more details. 

 
  “The permutation p-value is considered statistically unreliable because of insufficient sample size or an  
   unsuitable combination of genotyping data. For more information, please contact snpalyze support” 

Displayed when the degree of freedom has changed through the permutation test process in a Case- 
       Control Haplotype Analysis. If this message is displayed, select the “contingency table” checkbox in the  

  Permutation test setting. 
 *Please refer the 14-(3) Permutation test” to understand difference between two methods. 
 
 “The permutation p-value is considered statistically unreliable because of low frequency haplotypes.  
   Please perform permutation test with pool low frequency haplotypes option at Case-Control Haplotype  
   Analysis - permutation test setting. Refer to SNPAlyze manual for further information” 

Displayed when there is the possibility that rare haplotype will cause a large number of accidental  
       errors. The accidental error comes from the bias in number of haplotype that is caused by the permutation       
       test. In this case, select the “pool low frequency haplotype” checkbox in the Permutation Test setting. 

 
  “The Logistic Module is not available. 
  The Logistic Regression require installation of the HealthSkech Ver.2.5 or after.” 

Displayed when you cannot use the Logistic Regression Analysis. HealthSketch V2.5 or after is required 
for Logistic Regression Analysis. (In case of HeatlhSketch demo version, you can use the Logistic 
Regression Analysis within a time limit of the demo version.) 

 
 
 
(2)Linkage disequilibrium in Microsatellite 

Particular care is required when you are dealing with microsatellite data when performing a Linkage Disequilibrium 
Analysis. There is possibility that D’ value is overvalued by effect of alleles which have ultra-low-frequency. 
Refer to these papers below: 
 
Linkage disequilibrium in the human genome. 

Reich DE, Cargill M, Bolk S, Ireland J, Sabeti PC, Richter DJ, Lavery T, Kouyoumjian R, Farhadian SF, 
Ward R, Lander ES. Nature. 2001 May 10;411(6834):199-204. 

 
Extensive genome-wide linkage disequilibrium in cattle. 

Farnir F, Coppieters W, Arranz JJ, Berzi P, Cambisano N, Grisart B, Karim L, Marcq F, Moreau L, Mni M, 
Nezer C, Simon P, Vanmanshoven P, Wagenaar D, Georges M. Genome Res. 2000 Feb;10(2):220-7. 
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(3)Permutation Test 
  The configurable items on the Permutation Test setting are explained below: 
   ( Refer to section “10-(1) Permutation test tab.”) 
 

 Parameter frame >> 
  “Pool low frequency haplotypes” 

There is possibility of ultra-low-frequency haplotype in haplotype inference. Many occurrence of low-
frequency haplotype may cause accident errors in the results. If you select this checkbox, it is possible to 
totalize all low frequency haplotypes to one item. In this way, you can deal with all low-frequency 
haplotypes as one item and thereby reduce accident errors. 
If you select this checkbox, the “pooled haplotypes” is added in the contingency tab on result of the analysis. 
*The “pooled haplotypes” is not added when it does not influence the result. 

 
 Approach ftame >> 

 “Contingency table” 
SNPAlyze has adopted the Permutation Test to achieve high reliability of results in a Case-Control 
Haplotype Analysis. In the Permutation Test, SNPAlyze rearrange the original input data while keeping the 
number subjects intact. But if you adopt the Permutation Test for the original data sheet, there will be the 
possibility that the degree of freedom will change between the simulated data sheets. To avoid this, it is 
possible to apply the Permutation Test to a contingency table that is constructed from the original data sheet. 

 
Figure: Flow Diagram of Case-Control Haplotype Analysis 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Method 2: Check the “Contingency table” check box   

Original Data Sheet Haplotype Inference Definition of  
Contingency Table 

Calculation of  
Statistics 

Method 1: Check the “Haplotype Inference” check box  

Permutation 

Permutation 

Direction of flow 

Output Results 
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 The paper concerning the use of SNPAlyze 
This display shows the result obtained following a search for references using SNPAlyze on November 28, 
2007. 
 
*Since the user instruction manual may not be always available, the purposes of use or product names 
published in this manual may not be in agreement with your intended use. Please be sure to refer to 
instructions for confirmation. 
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